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1. Introduction

The LPC5460x is a family of ARM Cortex-M4 based microcontrollers for embedded
applications. The LPCXpresso development board for LPC5460x MCUs is used in this
technical note. See the following link for details of the board:

http://www.nxp.com/products/microcontrollers-and-processors/arm-processors/lpc-cortex-
m-mcus/lpc54000-series-cortex-m4-mcus/lpcxpresso-development-board-for-lpc5460x-m
cus:OM13092

Figure 1 shows the LPC54608 LPCXpresso development board.

Fig 1. LPC54608 LPCXpresso development board

This technical note gives an overview of the example developed using the on-board LCD
and Quad SPI flash via SPIFI.

TN00021_LPC54608 Allinformation provided in this document is subject to legal disclaimers. © NXP B.V. 2017. All rights reserved.

Technical Note Rev. 1.0 — 14 August 2017 30f15




NXP Semiconductors TN00021

LPC54608 LCD Dual Frame Buffer with Images loaded from Quad SPI

2. Description

Figure 1 shows the LCD with images loaded from Quad SPI through SPIFI direct memory
access. The program code resides in LPC54608 internal flash and data images reside in
the 16 MB Quad SPI flash.

2.1 LCDin 16BPP RGB565 with images data located in SPIFI

The example uses the on board 16MB Quad SPI flash and a 480 x 272 LCD screen. The
LCD controller is configured for 16 bits per pixel (BPP) RGB565 TFT mode and
implements dual frame buffers residing in on-board SDRAM. When the example is
executed, a 480 x 272 image is loaded from SPI flash via SPIFI's direct access at
0x1000_0000 memory region. When a touch is detected on LCD panel, another 480 x 272
image is displayed.

The example is available in three tool chains:

* MCUXpresso IDE v10.0
e Keil MDK v5.24
* |AR Workbench v8.11

The Keil and IAR examples are located in:
Ipc54608_Icd_spifi_keil_iar\boards\Ipcxpresso54608\demo_apps\icd_spifi_tft16bpp
The MCUXpresso example is in the zip file:

Ipc54608_Icd_spifi_16bpp_mcux.zip
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2.2 Converting Bitmap file to image filein C

Download the Bitmap converter from:

https://www.segger.com/downloads/emwin/

Extract and execute BmpCvt.exe. From the File menu, Open to select a BMP file. See
Figure 2. The LCD uses 16-bit RGB (5-bit red 6-bit green 5-bit blue) format. Converting
the image to 565 reduces the real-time MCU processing time to scale down or compress
the image(s).

ﬂ Bitmap Converter for emWin V5.22 - No file
iribe Edit View Image Options Help
Open... Ctri+D

Create Alpha-.

Load Alpha mask

Create animated sprite from GIF-
Create animated cursor from GIF-.

Save paletts

Fig 2. Selecting a BMP file

Click on the Image menu and select Scale if the resolution is larger than 480 x 272. See
Figure 4. Enter Width of 480 Pixels and Height of 272 Pixels. Uncheck the Keep
Proportion box. See Figure 4.

ﬁ Bitmnap Converter for emWin V5.22 - CA\Projects\L
L ; T v
: File Edit View |Image | Options Help

Resolution: 12 Transparency.-

Colors: Rt Convert to X

Zoom: & Flip » Original Size: 1280 x

Transparent— Roate :

Widih: i
Invert » ! 480 ® Picels
Shrink : Height. [272  Percer
Reduce Colors L
[ Keep Proportion:
Scale..
Info
Fig 3. Selecting scale Fig 4. Scaling an image

From the File menu, select Save as menu “C” bitmap file (*.c). Click Save button and a
Format specification dialog window appears. See Figure 5.
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12bpp (444_16).
12bpp (M444_16),
High color (555)

High color (558), red and blue sw

Fig 5. Format specification

2.3 Locating data in Quad SPI flash

There are multiple ways to populate data in Quad SPI flash at location 0x1000_0000. This
demo uses the preprocessor directives:

* Pragma(address) or #pragma location=address to allocate functions or variables in
named section for IAR.

* For Keil __attribute__ (( at(address) )) is used.
* For MCUXpresso __ RODATA(address) is used.

The same address defined in MCUXpresso can be used several times across multiple
variables, the compiler calculates and assigns the next offset. IAR and KEIL must define
each address location for each variable. The example of this setup is in images.c and
images.h.

Note: Preprocessor Symbol (GCC/IAR/MDK) is defined in C/C++ project option.
IAR:

_Pragma(location=0x10000000)

GCC_IMGIN_SPIFI static GUI_CONST_STORAGE unsigned short imagel[] = {.};
_Pragma(location=0x10040000)

GCC_IMGIN_SPIFI static GUI_CONST_STORAGE unsigned short image2[] = {.};

Keil:

__attribute__(( at(0x10000000) ))

GCC_IMGIN_SPIFI static GUI_CONST_STORAGE unsigned short imagel[] = {.};
__attribute__(( at(0x10040000) ))

GCC_IMGIN_SPIFI static GUI_CONST_STORAGE unsigned short image2[] = {.};
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MCUXpresso:

__RODATA(0x10000000) GCC_IMGIN_SPIFI static GUI_CONST_STORAGE unsigned short imagel[]
={.}

__RODATA(0x10000000) GCC_IMGIN_SPIFI static GUI_CONST_STORAGE unsigned short image2[]
={}

2.4 Notes

2.4.1 IAR reset type and macro setup:

When “Verify download” is checked, change reset type and provide macro file
(FlashLPC546x_spifi.mac must be used for Quad SPI and SPIFI to verify correctly).
Figure 6 shows the macro file provided with “Use macro file(s)” checkbox checked.

ot s oy T e

Categony: | Faciory Settings ]

Genesal Optiors
Static Anatyss

|Runtme Chedng | 'setup | Download | images | Exva Options | Mulicore | Phuging |
4+ Compler
Aesembler Diriver ¥1Run o

Qutput Comerier I 1
S |CMSIS DAR - main

Buald Autors Selup MALros

W Use macro fle{s)

Sammlator
CADp

CMSIS DaP
GDE Server
TetTTAGjet :
JeLi ) Trace Overide default

Dewice descpion file

Tl Stelaris STOOLKIT_DIRS\CONFIG debugger ML LPCS4608.0512 dif
PE o
STARN
Third-Party Driver
T MSP FET
s

Fig 6. Setup macros
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For CMSIS-DAP, change the reset type to Hardware. See Figure 6.

Options for node “lcd_spifi_tftl6bpp”

EGEIHJODM
| Stabc Analyss
| Rurvtame Chadeng Setup | Injerface inks |
s Inierface | Breakpoins |
Resel
Cufput Converter | Hardware: x

o Durason: 0 me Oelay aher 200 ms

Debugger Emulator
Samiator |—.Mﬂ promplfor probe
gt * selaction

ET—— st

bietjmagiet
Hirk/}Trace | Log communication
TI Saedlaris:

PE g

ST

Trird Party Driver
L MSRFET

TL XD5

EPROJ_DRScspycomm log

Fig 7. CMSIS-DAP setup

For JLink, change the reset type to Connect during reset. See Figure 8.

Seup |Connechan | Breskpoints|

Resat

Core
*Core and penpherals
Fezat Pin

Frii] MHE

Hal afber boaloader
Halt befora booloadar [ Auio

Adaptive Kz

ETMETE
" Prafer ETB

Fig 8. J-LINK setup
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2.4.2 Adding 16MB Quad SPI flash to Flash programming in Keil

From the Flash menu, select Configure Flash Tools to bring up flash configuration. See
Figure 9.

KA C:\Projects\LPC\Ipc54608_lcd_spifi_keil_iar\boards\Ipcpresso54608
File Edit View Project Fla:s-hl[)abug Peripherals Tools SVCS

(1 E d @ » & %8 Download F8
:5@@@@ | 52 Erase
Project Configure Flash Tools..

= "ﬁ$ Project: led_spifi_tftl6bpp ;{
= &3 lcd_spifi_tftl6bpp Debug

Fig 9. Flash configuration

Under the Utilities tab, click Settings button. See Figure 10. This brings up the Cortex-M
Target Driver Setup dialog box. See Figure 11.

Options or Torget 1cdpifl 16opp Debug W e

Device | Target| Output | Listing | User | C/C++| Asm | Linker | Debug  Utiliies | |

— Configure Flash Menu Command
@ Use Target Driver for Flash Programming [+ Use Debug Driver
== Use Debug Driver — Sefings [+ Update Target before Debugging

Init File: | J Edit.
("~ Use Exemal Tool for Flash Programming

Cummand.'l J

Azgumams:l
r‘ X

Configure Image File Processing (FCARM):

K Qutput File: Add Qutput File 10 Group:
I | |board -]
" Imaga Filas Root Folder | [~ Generate Lising
[ ok | concel | Defauts | Help ||

Fig 10. Debugger settings
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Click on Add button to bring up flash programming algorithm selection.

Cortex-M Target Driver Setup © ™ W e s
Debug| Trace Flash Download |pur.; |
Download Function FAM for Algorithm
Lo (" Erase FullChip  [¢ Program
53 ® EraseSectors [ Variy Start 220000000 Size: [x1000
(" DoneclErase [~ Resetand Run
Programming Algorithm
Description | Device Size | Device Type | Address Range |
LPCE4Bx IAP 51288 Flash 512k On-chip Flash DOOGO000H - D0ATFFFFH

Statt | Size: |

| 0K | Cancel J Help

Fig 11. Cortex-M target driver setup

Select LPC5460x MT25QL128 SPIFI. Click Add button to continue. See Figure 12.
MT25QL128 SPIFI is added, click OK to continue. See

Add Flash Programming Algorithm - ]
Description | FlashSize | Device Type | Ornigin |
LPC5460x AP 512kB Flash 512k On-chip Flash  Dewice Family Package
AMZ9x 128 Flash 16M Ext Flash 16-bit MDK Core
KBPS615UQA Dual Flash B4M Ext Flash32-bit MDK Core
LPC18xoy4 Joc 325FL032 SPIFI 4M Ext Flash SPI MOK Core
LPC18hog4 Do 525FLI064 SPIFI &M Ext FlashSPl  MDK Core

| LPCA407x/8x S25FL032 SPIF] 4M Ext Flash SPI MOK Core
. LPC5460x MT250L128 SPIFI Ext FlashSPlI MDK Core
| M29WE40FE Flash M Ext Flash 16-bit MDK Core
RC28FB40J3x Dual Flash 16M Ext Flash 32-bit MDK Core
S29GL064M Dual Flash 16M Ext Flash 32-bit MDK Core
S29JL032H_BOT Flash 4M Ext Flash 16-bit MDK Core
S29JL032H_TOP Flash 4M Ext Flash 16-bit MDK Core

C:\Keil_v5\ARM\flash\LPC5460x_MT250L128FLM

| Add Cancel |
Fig 12. Add flash programming algorithm
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Cortex-M Target Driver Setup WA DL e Mgy - o
Debug| Trace Fiash Download ]pgck |
Download Function 1~ RAM for Algorithm
(" EraseFullChip [+ Program
E% @ EraseSeclors [ Veriy Start: [(x20000000 Size: [In4000
(" Do notErase [T Resetand Run
—Programmang Algarithm

Descrption | Device Size I Device Typa I Address Range |

LPC5460x IAF 512kB Flash 512k On-chip Flash 00000000 - DDOFFFFFH

LPCE4B0x MT250L128 S 1eM Ext Flash SP| 10000000H - 10FFFFFFH

St | Size: |

Add | Remave |

OE_I Cancel | Help

Fig 13. Adding MT25QL128 SPIFI

2.4.3 MCUXpresso project bring up

Create a new workspace by providing a name to MCUXpresso workspace.

[ Ectipse Launcher = -
Select a directory as workspace

MCUXpresse IDE uses the workspace directory to store its preferences and development artifacts.

Workspace: | Z\Documents\MCUXpressolDE_L0.0.0_344\ipc54608-ledspifi v [ Browse—

| Lise this as the default and do not ask again ]
* Recent Workspaces !

oK | cancel |

Fig 14. Creating a workspace

Download SDK_2.x_LPCXpresso54608 from:

https://mcuxpresso.nxp.com/en/welcome

Select Installed SDKs tab in MCUXpresso to make the tab active. Drag and drop the SDK
zip file to the tab. Make sure the check box in front of the SDK package is checked.
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@ Installed SDKs =2 | [C] Properties & Console | Problems [ Memory $ Instruction Trace
i/ Installed SDKs
To install an SDK, simply drag and drop an SDK (zip file/folder) into the 'Installed SDKs' view.

Mame Version Location
[¥] & SDK_2x_LPCXpresso54608  2.2.0 ic} SDK_2.x LPCXpres:

Fig 15. Installed SDKs

Click on Import project(s) from file system at bottom left panel.

B McuXpresso IDE (Free Edition)

~ Start here
M rew project...
B 1mport SDK examplels).

& Import project(s) from file system...
%

P

Fig 16. Importing projects

Locate and select the Ipc54608_Icd_spifi_16bpp_mcux.zip file.

B 1mport project(s) from file system... T 5] e |
e e ee i S - s T —
Import project(s) from file system... B
Select the examples archive file to import. A

Projects are contained within archives (.zip) or are unpacked within a directory. Select your
project archive or root directory and press <Next>. On the next page, select those projects you
wish to import, and press <Finish>.

Praject archives for LPCOpen and ‘legacy’ examples are provided.

Project archive (zip) |
Archive ChDocumnents\MCUXpressolDE_10.0.0_344\1pc54608_led_spifi_16bpp_meouwxzip | Browse...
Project directory (unpacked)

Root directory Browse_ I
LPCOpen

LPCOpen is the recommended code base for Cortex-M based NXP LPC Microcontrollers. |

MCUXpresso IDE includes the LPCOpen packages which can be imported directly by pressing the Browse
button in the Project archive (zip) section, above, and navigating to the Examples/LPCOpen directory.

Alternatively, press the button befow to Browse the nxp.com website for latest resources.

lBrumse LPCOpen resources on nxp.com...

@

() Back Next Finish | Cancel

Fig 17. Selecting project from archives
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Issues

IAR linker warning message

Warning[Lt009]: Inconsistent wchar_t size
board.o and 36 other objects have wchar_t size 16 bits
GUI DrawBitmap_565.0(libemWin_M4F.a) and 128 other objects have wchar_t size 32 bit

There is an update to wchar_t size from 16 bits to 32 bits in IAR version 8.11. The library
used to compile in version 8.10 or older sets wchar_t size to 16-bit. A release note from
IAR can be found at the link:

https://netstorage.iar.com/SuppDB/Public/UPDINFO/012120/arm/doc/infocenter/iccarm.E
NU.html

Remark: An update to the fsl_power _lib.a library to use 32 bits wchar_t size will be
available at the next SDK release.

Keil flash programming progress bar delay

When downloading or debugging the code, the flash program for Quad SPI flash progress
bar seems to stop around 40-50%. Wait for around 30 secs to 1 min. The progress bar will
reach 100% and complete the programming.

Raw binary

Attempt to generate raw binary creates at least a 256 MB file due to internal flash region
at 0x000_0000 and Quad SPI flash region at 0x1000_0000. Raw binary does not contain
header to isolate the two offsets, ELF and SREC formats do.
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